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Smilow Center for Translational Research, SCTR 09-146 A/B  
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Organized by the Penn Image Computing and Science Laboratory !
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Overview. ITK-SNAP is a free, open-source software tool for interactive segmentation of 3D image vol-
umes. It is used by thousands of researchers to label structures of interest in different imaging modalities, in-
cluding MRI, CT, 3D ultrasound, and others. It includes both manual and automatic segmentation functionality, 
and it designed to be easy to learn and use. Since 2006, ITK-SNAP has has contributed to over 1000 publica-
tions, spanning a wide range of biomedical applications and imaging modalities.  !
Objectives. The class is aimed at both novice and experienced ITK-SNAP users. Attendees who complete 
the morning session will be able to use ITK-SNAP autonomously to perform common operations, such as im-
age viewing, manual segmentation and semi-automatic segmentation. Attendees of the afternoon session will 
be able to develop image data processing and analysis workflows that integrate ITK-SNAP and the companion 
Convert3D 3D image processing tool. To meet these objectives, the training session will combine presentations 
by ITK-SNAP experts with guided exercises. Attendees must bring their own laptop to the session.  !
Website. http://www.itksnap.org/pmwiki/pmwiki.php?n=Main.Training !

Start 
Time

Duration Topic Presenter

8:30 AM 10 General Introduction and Logistics 
* what is ITK-SNAP? 
* materials and handouts 
* plan for the day

Paul Yushkevich

8:40 AM 20 Session 1: Installing ITK-SNAP and C3D 
* walk through installing on Windows, MacOS and Linux 
* quickly go over the contents of the data folder

Paul Yushkevich

9:00 AM 20 Break 
* during the break, help users install 

9:20 AM 20 Session 2: Theory: Working with 3D Medical Images 
* how ITK-SNAP represents images 
* how segmentations are represented 
* types of layers in ITK-SNAP 
* file formats and meta-data

Paul Yushkevich

9:40 AM 60 Session 3: Hands on Image Navigation (Follow-Along Session) 
* loading a NIFTI format grayscale image 
* cursor positioning, looking up coordinates 
* different zoom modes (linked zoom, specifying zoom level) 
* contrast adjustment, color map 
* loading a segmentation image 
* volumes and statistics 
* using workspaces 
* small exercise to reinforce material

Paul Yushkevich

10:40 AM 15 Break

http://www.facilities.upenn.edu/maps/locations/smilow-center-translational-research
mailto:pauly2@mail.med.upenn.edu
http://www.itksnap.org/pmwiki/pmwiki.php?n=Main.Training


!

10:55 AM 65 Session 4: Manual Segmentation (Lecture + Exercise) 
* polygons: drawing, editing, pasting, undo, etc. 
* advantages of tracing in three slice planes 
* adding and modifying labels 
* paint brush: plain and adaptive 
* undo and redo 
* label selection and label editor 
* practical exercise: hippocampal subfields in a postmortem MRI. Ex-

ercise will reinforce above skills, as well as loading and saving seg-
mentations, computing volumes. 

John Pluta

12:00 PM 60 Lunch (on your own)

1:00 PM 45 Session 5: Working with Multiple Imaging Modalities 
* working with image overlays 
* layer inspector, component selection 
* yoking between ITK-SNAP sessions 
* working with DICOM datasets

Sandhitsu Das 

1:45 PM 25 Session 6: Automatic Segmentation: Theory 
* intuitive, hands-on explanation of automatic segmentation concepts 
* active contour evolving according to forces  
* speed images generated by thresholding and edge detection 
* automatic merging of contours 
* what sorts of problems does this segmentation work for?

Alison Pouch

2:10 PM 30 Session 7: Automatic Segmentation: Practice 
* hands-on exercise to segment 4D ultrasound data 
* experiment with parameter tuning 
* perform supervised classification in multi-modality MRI

Alison Pouch

2:40 PM 15 Break

2:55 PM 30 Session 8: 3D Navigation and Editing 
* manipulating segmentation in 3D with cut-plane tools 
* exercise: users will be provided with initialization and speed images 

for automatic segmentation of the ventricles; will run automatic seg-
mentation, then split the ventricles into left, right and third ventricle.

John Woo 

3:25 PM 60 Session 9: Convert3D Basics (Interleaves Lecture and Exercises) 
* image arithmetic, basic image processing 
* slicing, stacking, resampling, transformations, cropping, etc. 
* analyzing and comparing segmentations, computing overlaps 
* batch application of ITK-SNAP automatic segmentation

Philip Cook 

4:25 PM 5 Wrap-Up Paul Yushkevich

4:30 PM Dismissal
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Session 1 - ITK-SNAP Installation !
Exercise 1-A.  Installation on Apple MacOS 

!
Objective. Install ITK-SNAP and Convert3D programs on Apple MacOS !
Duration: 15 minutes. !!
Step 1. Locate and Open the Training Course Archive 

• From USB drive: copy the folder itksnap_training_2014 from the USB drive to Desktop!
• From the Internet:!

• Download the folder contents from http://picsl.upenn.edu/data/itksnap_training_2014.zip!
• Click on the file itksnap_training_2014.zip in your Downloads folder to decompress it!
• Copy the folder itksnap_training_2014 to the Desktop!

• At the end of this step, you should have a folder named itksnap_training_2014 with the contents of 
the training session on your Desktop!!

Step 2. Install the ITK-SNAP application 

• Enter the folder itksnap_training_2014/Software/MacOS!
• Double click the icon for itksnap-3.2.0-rc2-20140919-MacOS-x86_64.dmg 

• Accept the license!
• Drag the icon ITK-SNAP.app on top of the icon Applications in that folder!
• Similarly, drag the icon itksnap on top of the icon usr_local_bin in that folder!

!
• !

http://picsl.upenn.edu/data/itksnap_training_2014.zip


• To add the ITK-SNAP launcher to your Dock, enter the Applications folder and drag the ITK-SNAP.app icon 
onto the Dock.!

� !!
• Click the ITK-SNAP icon in the Dock to launch ITK-SNAP!

Step 3. Install the Convert3D application 

• Enter the folder itksnap_training_2014/Software/MacOS!
• Double click the icon for c3d-1.0.0-MacOS-x86_64.dmg!

• Accept the license!
• Drag the icon Convert3DGUI.app on top of the icon Applications in that folder!
• To add the ITK-SNAP launcher to your Dock, enter the Applications folder and drag the ITK-SNAP.app icon 

onto the Dock. 



Exercise 1-B.  Installation on Windows 

!
Objective. Install ITK-SNAP and Convert3D programs on Windows platforms !
Duration: 15 minutes. !!
Step 1. Locate and Open the Training Course Archive 

• From USB drive: copy the folder itksnap_training_2014 from the USB drive to the desktop!
• From the Internet:!

• Download the folder contents from http://picsl.upenn.edu/data/itksnap_training_2014.zip!
• Double-click on the file itksnap_training_2014.zip in your Downloads folder to decompress it!
• Copy the folder itksnap_training_2014 to the desktop!

• At the end of this step, you should have a folder named itksnap_training_2014 with the contents of 
the training session on your desktop!!

Step 2. Install ITK-SNAP 

• Enter the folder itksnap_training_2014/Software/Windows!
• Double-click the icon itksnap-3.2.0-rc2-20140919-win32-AMD64.exe!
• Follow the installation instructions in the wizard (illustrated below)!

!!

http://picsl.upenn.edu/data/itksnap_training_2014.zip


Step 3. Launch ITK-SNAP 

• Run ITK-SNAP from the Windows Start Menu!

!
Step 4. Install and Run Convert3D 

• Enter the folder itksnap_training_2014/Software/Windows!
• Double-click the icon c3d-1.0.0-MacOS-x86_64.exe!
• Follow the installation instructions in the wizard!
• Launch the Convert 3D GUI from the Windows Start Menu!

!!



Exercise 1-C.  Installation on Linux 

Objective. Install ITK-SNAP and Convert3D programs on Linux platforms !
Duration: 15 minutes. !!
Step 1. Locate and Open the Training Course Archive 

• From USB drive: copy the folder itksnap_training_2014 from the USB drive to Desktop!
• From the Internet:!

• Download the folder contents from http://picsl.upenn.edu/data/itksnap_training_2014.zip!
• Click on the file itksnap_training_2014.zip in your Downloads folder to decompress it!
• Copy the folder itksnap_training_2014 to the Desktop!

• At the end of this step, you should have a folder named itksnap_training_2014 with the contents of 
the training session on your Desktop!!

Step 2. Install ITK-SNAP 

• Open a Linux terminal!
• Enter the folder itksnap_training_2014/Software/Linux/!

> cd ~/Desktop/itksnap_training_2013/Software/Linux/!

!
• Uncompress the file containing ITK-SNAP software for your system (32 bit or 64 bit)!

> tar -zxvf itksnap-3.2.0-rc2-20140919-Linux_x86_64.tar.gz!

!
• Copy the contents of the uncompressed folder into /usr/local. On most systems, this is done using the 
sudo command.!!

sudo cp -av ./itksnap-3.2.0-rc2-20140919-Linux_x86_64/ /usr/local/!

!
Step 3. Launch ITK-SNAP 

• Open a Linux terminal!
• Running the following command should cause ITK-SNAP to launch!

itksnap!

!
Step 4. Install Convert3D 

• Enter the folder itksnap_training_2014/Software/Linux!
• Uncompress the file containing Convert3D software for your system (32 bit or 64 bit)!
• Copy the contents of the folder to /usr/local (as above for ITK-SNAP)!
• Run the following command to open the Convert3D GUI!

Convert3DGUI

http://picsl.upenn.edu/data/itksnap_training_2014.zip


Session 3 - Image Navigation !
Exercise 3-A.  Image Navigation Basics 

!
Objective. This exercise reinforces the image navigation techniques covered in the lecture. After complet-
ing the exercise, you will be able to load images, perform basic navigation tasks, and adjust image contrast.  !
Duration: 10 minutes. !
Data:  The data for this exercise are located in the folder !

Materials/Session03_Navigation/data/exercise!

!!
Step 1. Load the Brain Image 

• Launch ITK-SNAP!
• Open the wizard for loading an anatomical image (File->Open Image)!

� !
• Press Browse to search for an image file to load!
• Select the image 1004_3.nii.gz in the Session03_Navigation/data/exercise folder. !
• Press Next. The wizard will list summary information about the image. !!

� !!
• Press Finish. ITK-SNAP main window should now show three orthogonal views of a brain MRI scan.!

What are the dimensions of the image you just 
loaded?!!

________ by ________ by ________



� !
Step 2. Quick Contrast Adjustment 

• Open the contrast adjustment window (Tools->Image Contrast)!
• Press Auto to adjust the contrast automatically. !

 � !!
Step 3. Focus on the Left Hippocampus 

• Position the 3D cursor in the middle of the left hippocampus (see illustration below).!!

!  

What are the level and window after automatic con-
trast adjustment?!!

Level:  ________  Window:  ________



• In the control panel on the left of the ITK-SNAP window, select the Zoom Inspector (shown below) 
and verify that Linked Zoom option is checked!

• Set the common zoom factor to 4 pixels per millimeter!!

� !!
• Pan in each of the slice views so that the hippocampus is centered in each view!

� !!



Step 4. Fine Contrast Adjustment 

• Re-open the contrast adjustment window!
• Change the shape of the intensity transfer function to maximize contrast between different tissues in the 

hippocampus region.!!

!  
Step 5. Load the Segmentation Image 

• Load the segmentation image (Segmentation->Open Segmentation …) from the file 1004_3_seg.nii in 
the data folder!

• Load the label description file (Segmentation->Import Label Descriptions) from the file anat_labels.txt!
• Adjust the overall label opacity to 96!
• Press Update Mesh in the 3D view to render the surface of the segmentation!

� !!



Step 6. Compute Volumes and Statistics 

• Open the volumes and statistics dialog (Segmentation->Volumes and Statistics …)!!

� !

What is the volume of the left hippocampus (label 48)?!!
________ mm3!!

What is the average intensity of the left hippocampus?!!
________



Session 4 - Manual Segmentation !
It is strongly recommended that you use a mouse for manual segmentation !!!

Exercise 4-A.  Create Custom Label File 

!
Objective. After completing the exercise, trainees will be able to create a label file with 
custom names and colors appropriate for their segmentation work. !
Duration: 5 minutes. !!
Step 1. Prepare the Image for Segmentation 

• Launch ITK-SNAP!
• Load the anatomical image pm_hipp.nii in the Materials/Session04_ManualSeg/data folder.!
• Using the magnifying glass tool, zoom in on the coronal view to a resolution of 20px/mm.!
• Adjust image contrast (Tools->Image Contrast->Auto Adjust Contrast)!!

Step 2. Create and save custom label file 

• Under ‘Tools’, click on ‘Label Editor’!



!
• Under ‘Description’, change ‘Label 1’ to ‘CA’; Change ‘Label 2’ to ‘SRLM’; Change ‘Label 3’ 

to ‘DG’!
• Change the color of SRLM to light blue (0, 200, 255); leave CA as red and DG as dark blue!
• Close the Segmentation Label Editor!
• Save the custom label file. (Actions->Export Label Descriptions->‘subfield_labels.txt’)!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!



!
Exercise 4-B.  Using the Polygon Tool 

Objective. After completing the exercise, trainees will be able to manually create a 
segmentation of multiple labels using the polygon tool. !
Duration: 10 minutes. !
Step 1. Segment CA, DG, and SRLM 

• In the coronal plane, navigate to slice 223 of 420!
• Select the polygon tool in the Main Toolbar.!!

� !!
• Select ‘CA’ as the foreground label, and ‘All labels' as the background label. Trace CA using 

the polygon tool, as in the figure below. Click ‘Complete -> Accept’ to fill in the area.!



• Select ‘DG’ as the foreground label; select ‘All labels’ for the background label. Trace DG on 
the same slice as CA. Click ‘Complete->Accept’ to fill in the area.!!

� !!
• Using the Label Inspector from the Active Tool Inspector Menu, or the Quick Label Inspector 

button from the Main Toolbar, selection ‘SRLM’ as the foreground label and ‘Clear Label’ as 
the background label. Fill in the space between DG and CA1 as SRLM. By selecting ‘Clear 
Label’, only empty voxels will be filled in with SRLM; CA and DG voxels are unaffected.!!

!!!!!!!



!!!
• The final segmentation should appear similar to the image below:!!

� !!!!!



Exercise 4-C.  Using the Paintbrush Tool 

Objective. After completing the exercise, trainees will be able to manually create a 
segmentation using the polygon and paintbrush tools, and save the segmentation file. !
Duration: 15 minutes. !
Step 1. Segment a coronal slice 

• In the coronal plane, navigate to slice 224 of 420!
• Segment CA, DG, and SRLM using the polygon tool, as in Exercise 4-B.!
• In the ‘Main Toolbox’ panel, select the paintbrush tool. You should see the‘Active Tool 

Inspector’ become active, as shown below:!
                                       !

� !!
• Select ‘Brush Style:Shape->Square’!
• Select ‘Paintbrush Tool:Size->1’!
• Use the paintbrush tool to refine the segmentations!!

Step 2. Continue segmenting the hippocampal subfields 

• In the coronal plane, navigate to slice 225 of 420.!
• Repeat Step 1.!!

Step 3. Save your work 

• Save the segmentation (Segmentation->Save “Segmentation.nii” )!!!!



Exercise 4-D.  3D Rendering 

Objective. After completing the exercise, trainees will be able to render their segmentation 
in 3D. !
Duration: 5 minutes. !
Step 1. Render segmentations 

• In the 3D view  (bottom left), click ‘Update’ to render the segmentation in 3D.!

• Rotate the segmentation (3D Toolbox->Trackball Tool).!

• Select the crosshair tool and place it anywhere on the 3D rendering. !



Session 5 - Overlays and Multiple Imaging Modalities 

Exercise 5-A.  Overlays

Objective. After completing the exercise, trainees will be able to load multimodal imaging data in ITK-SNAP, 
visualize them using the tile and stack interfaces, and access basic overlay settings from the intensity panel.

Duration: 10 minutes.

Step 1. Load the Main and Overlay Image

• Launch ITK-SNAP
• Open the workspace file Session05_Multimodality/data/Overlay.itksnap. 

Step 2. Toggle between stack and tile view
• Click the stack/tile view icon shown with the red arrow 
• Use the q, w, and e keys in stack mode to change the opacity of the overlay image.  



Step 3. Use the intensity panel
• Click on different parts of the image and note the intensity panel on the left to read out image values.
• Right-click (Ctl-Click on Mac) on the overlay image file name in the intensity panel to access overlay image 

settings.  

• Auto-adjust the contrast of both images. Change the colormap of the overlay image to hot.

• Switch to stack view and use the opacity control to visualize overlay image.



Exercise 5-B.  Finer control of overlay images via layer inspector

Objective. After completing the exercise, trainees will be able to use the layer inspector to control various 
settings for overlay images.

Duration: 10 minutes.

Step 1. Load a multicomponent image

• Revert to the tile view
• Load a second overlay image file MultiComponent.nii.gz

Step 2. Use the layer inspector window - part 1
• Open the layer inspector window with Ctl+I (Command+I on Mac)



• Select the MultiComponent image on the overlay panel on the left hand side. In the Contrast tab, click Auto 
to set contrast automatically.

• Now manually set the contrast curve to be symmetric around zero, with a min/max of -150/+150.

• Use the tile/stack button on the layer inspector to switch to stack view. 
• Use the “eye” button to individually toggle overlay layers to be visible/invisible.
• Use the opacity slider.



Step 3. Use the layer inspector window - part 2
• Use the colormap tab to change the colormap of the multicomponent image to “blue to white to red”.



• Create two new control points on the colormap to decrease the opacity of the zero point to zero, increasing 
to 100% at 0.4 and 0.6 on either side.

• In the layer inspector, right-click (ctl-click for Mac) the multicomponent image and select Component 2.
• In the contrast tab, change the minimum and maximum to -250 and 250 respectively. Note that the color-

map for Component 1 is automatically adjusted to the new setting.

• Use the pin button and the up-down button to change the visibility and ordering of layers.



Exercise 5-C.  Loading multimodality data using DICOM images and use yoking

Objective. After completing the exercise, trainees will be able to load a DICOM image into ITK-SNAP and 
yoke two or more ITK-SNAP sessions.

Duration: 10 minutes.

Step 1. Load a DICOM image

• Load any of the dicom files in the Session05_Multimodality/data/dicomfolder folder.
• ITK_SNAP recognizes this as a DICOM file. Change the Image file format to DICOM Image Series.
• Click Next.

• ITK-SNAP recognizes multiple DICOM image series present in the directory. Choose Series number 2, 
MPRAGE.



Step 2. Yoke two ITK-SNAP sessions
• Open a new ITK-SNAP window from the File menu.
• Repeat Step 1. above, selecting any dicom file, but this time load series number 4, Axial T2-FLAIR.



• The two ITK-SNAP windows are now yoked. 

Step 3. Control yoking behavior
• If you are running short of screen space using multiple windows, you can detach the toolbar and use single 

view mode to manage space.



• Click on the two windows to see how ITK-SNAP synchronizes the cursors.
• Zoom in and out and pan on one image and see how the other window does the same thing.
• Click on the synchronization inspector button on the new ITK-SNAP window just opened.

• Toggle the various individual synchronization settings in the two windows and navigate to observe the yok-
ing behavior.



Session 7 - Automatic Segmentation

Exercise 7-A.  Automatic Segmentation of the Left Ventricle in 3D Ultrasound 

Objective. This exercise guides trainees through an automated segmentation of the left 
cardiac ventricle in a multi-component 3D ultrasound image, where each component represents 
a 3D image of  the ventricle at a given time point of the cardiac cycle. After completing the 
exercise, trainees will be familiar with the interactive automated segmentation utilities in ITK-
SNAP and be able to use them for application-specific segmentation tasks. 

Duration: 20 minutes.

Step 1. Load the anatomical image

• Launch ITK-SNAP.
• Open the image left_ventricle_3DUS_MC.nii.gz in the Materials/
Session07_AutoSegPractice/data folder.

Step 2. Animate the 3D multi-component image

• Select the Layer Inspector icon  in the Main Toolbar. The Image Layer Inspector Window 
will open.

• Check the Animate box to view the sequence of components. The components of this data 
are 3D images of the left ventricle at sequential time points in the cardiac cycle.

• Uncheck the Animate box and select a component to segment (Component 3, for example). 
• Select Close to exit the Image Layer Inspector Window.



Step 3. Use the snake ROI tool to select a region of interest 

• Select the Snake ROI tool icon  in the Main Toolbar panel. 
• Adjust the red box in each of the three image planes so that the left ventricular chamber is in 

the region of interest.
• Select Segment 3D.



Step 4. Preprocess the grayscale image
• Select Thresholding as the Presegmentation mode in the Actions panel. This option uses a 

region-based approach to image segmentation, which assumes that objects of interest are 
roughly homogeneous in image intensity.

• Select the More... button in the Actions panel. The Speed Image Generation window will 
open.

• Select the  button to view the thresholded image superimposed on the grayscale image. 
Using a two-sided threshold, adjust the lower and upper thresholds so that the left 
ventricular chamber is the color of your segmentation label. (In this example, Label 1 is red.) 
For example, try a lower threshold of 32 and an upper threshold of 80.

• Now select the  button to view the speed image. Note that the foreground is white, the 
background is blue, and the edges are black. 

• Select Close to exit the Speed Image Generation window.
• In the Actions panel, select Next.



Step 5. Initialize image segmentation
• Place the cursor somewhere within the left ventricle and then select Add Bubble at Cursor in 

the Actions panel. 
• Select Next.



Step 6: Run the segmentation

• Click the play button  in Actions panel, and watch the contour evolve and fill the left 
ventricular chamber.

• Select the update button under the bottom left panel to visualize the 3D segmentation.

• Click the pause button  when the entire left ventricle has been labeled. You have now 
completed the automated segmentation. Note that the left ventricle is roughly football-
shaped. The segmentation may “leak” into other areas of the image.



Step 7. Experiment with the active contour parameter settings
Now the segmentation will be repeated to observe how the active contour parameter settings 
influence the segmentation result.

• Select Set Parameters... in the Actions panel. The Active Contour Evolution Parameters 
window will open.

• Adjust the slide bars to change the active contour parameters. For example, increase the 
curvature force and decrease the region competition force to obtain a smoother, less 
detailed segmentation.

• Select the Close button to exit the Active Contour Evolution Parameters window.

• Click the reverse playback  button in the Actions panel. This will reset the segmentation 
to the previously initialized bubble.

• Click the play button to repeat the segmentation. Observe how the changed parameter 
settings affect contour evolution and the final segmentation.

• When the segmentation is complete, select Finish to return to the main display.



Step 8. (Optional) Repeat the segmentation with new settings
Repeat steps 3 - 7 several times, each time experimenting with different active contour settings.

• Select Segmentation->Unload Segmentation to clear the current segmentation and start 
over.

• First, experiment with ROI resampling. In step 3, check the Resample ROI checkbox 
before clicking Segment 3D. Then click Segment 3D and choose to either down-sample or 
up-sample the grayscale image. For example, select Supersample by 2 or Subsample by 
2 in the Presets drop-down menu in the Resample ROI window.

• Second, try using an edge-based speed function to guide contour evolution. In step 4, 
select Edge Attraction instead of Thresholding as the Presegmentation mode. Then repeat 
steps 5 - 7. Note that the parameter settings in step 7 include balloon, curvature, and 
advection forces. 



Exercise 7-B.  Automatic Segmentation of a Brain Tumor in MRI Data

Objective. This exercise guides trainees through an automated segmentation of a brain 
tumor in multimodal MRI. After completing the exercise, trainees will be familiar with the 
interactive automated segmentation utilities in ITK-SNAP and be able to use them for 
application-specific segmentation tasks. 

Duration: 20 minutes.

Step 1. Load the multicomponent image

• Launch ITK-SNAP.
• Open the workspace BRATS_workspace.itksnap in the Materials/
Session07_AutoSegPractice/data folder.

• Note that you can tile the image overlays side-by-side or render the image overlays on top 
of one another using the  icon indicated by the red circle below.



Step 2. Use the snake ROI tool to select a region of interest

• Select the Snake ROI tool icon  in the Main Toolbar panel. 
• Adjust the red box in each image plane so that the brain tumor is in the region of interest. 

Note that in this example we are viewing the image overlays on top of one another (rather 
than using the tile view).

• Select Segment 3D.



Step 3a. Preprocess the grayscale image: select tissue classes
• Select Classification as the Presegmentation mode in the Actions panel. This option uses 

supervised classification to identify image regions (tissue classes).
• Use the paintbrush or polygon tools to mark examples of tissue classes. In this case, the 

active tumor is red, edema is green, cortex is dark blue, and the image background is 
yellow. Note that edema is easiest to identify in the FLAIR image, while the active tumor is 
easiest to identify in the T1C image.



Step 3b. Preprocess the grayscale image: train the classifier and generate the speed 
image

• Select the appropriate Foreground class (foreground label) in the Actions panel. In this case, 
we use red as the foreground label for the active tumor.

• Select Train Classifier, which will generate a speed image (blue and white) for the selected 
foreground label.



Step 4. Initialize image segmentation
• Place the cursor somewhere within the brain tumor on the speed image and then select Add 

Bubble at Cursor in the Actions panel. 
• Select Next.



Step 5: Run the segmentation

• Click the play button  in the Actions panel, and watch the contour evolve.
• Select the update button under the bottom left panel to visualize the 3D segmentation.
• Select Finish when the entire brain tumor has been labeled to exit the segmentation mode.

Step 6: (Optional) Repeat the segmentation with different training sites
Repeat steps 2 - 5, this time training the classifier using different training sites.

• Select Segmentation->Unload Segmentation to clear the current segmentation and start 
over.

• Select the ROI in Step 2. Then in Step 3a, change the way in which you label training 
sites. For example, make the training sites (labeled areas) smaller or larger. Try using two 
labels (tumor and cortex) without using a label for the background. How does this change 
the segmentation result?



Session 08 - 3D Navigation and Editing !
Exercise 8-A.  Extract Whole Human Lungs Simultaneously 

!
Objective. Provided with proper initialization, trainees will be able to do an automatic segmentation of the 
whole human lungs using the Snake mode (Active Contour Segmentation). !
Duration: 10 minutes. !!
Step 1. Load the CT image and initial segmentation (bubbles) 

• Launch ITK-SNAP!
• Open the wizard (File->Open Image) to load a grayscale image lungCT.nii.gz in folder Session08_-
Nav3D/data.!

• Open the wizard (Segmentation->Open Segmentation) to load an initial segmentation lung_bubbles.ni-
i.gz in folder Session08_Nav3D/data.!

• ITK-SNAP window should now show lungs with initial red bubbles!

!! !
Step 2. Region based Snake segmentation 

• Press Active Contour Segmentation (Snake) mode to initiate Snake segmentation and press Segment 3D.!
• On the right panel, set Lower threshold to -1023 and Upper threshold to -400. Press Next to finish Step 1 of 

3 (Preprocessing).!
• Press Next again to skip Step 2 of 3 (Snake Initialization). No need to place bubbles.!
• Set Step size in Actions: B to 10 to get the fast evolution and press the play button.!



!
• Wait until the Iteration reaches about 700 and press the pause button, which was the play button originally.!
• Press Finish and go to menu Segmentation and Save lung_bubbles.nii.gz as lungs.nii.gz in 

folder Session08_Nav3D/data.!
• Press update at the bottom of the 3D view panel to see a 3D rendering of the segmentation result.!

N.B. The above Step 2 can be skipped by loading the workspace file CT_wholeLung.itksnap in folder 
Session08_Nav3D/data, which includes an almost identical result. !!!
Exercise 8-B. 3D Navigation and Editing 

!
Objective: After the exercise, trainees will be able to visualize, navigate and edit 3D surface rendering in ITK-
SNAP. !
Duration: 20 minutes !
Step 1. Load the grayscale image and lung segmentation from Exercise 8-A or load the workspace file 
CT_wholeLung.itksnap in folder Session08_Nav3D/data. 

• Press update at the bottom of the 3D view panel to bring up the 3D surface rendering!!
Step 2. In 3D Toolbar at the bottom left, rotate, zoom and pan 3D view using 3D Trackball 

• Press 3D Trackball Mode!



!!
• Click and hold left mouse button in the 3D view panel to rotate the view. If you are using a trackpad, try 

pressing the pad and holding to rotate. You can also rotate around the axis perpendicular to the screen by 
holding the “command” key, pressing pad and moving on a Mac trackpad. On Windows, hold Control button 
when rotating. !

• Click and hold right mouse button to zoom. On a Mac trackpad, holding “control” key, press pad and move 
up and down.!

• Click and hold middle button to pan. On a Mac trackpad, holding “shift” key, press pad and move up and 
down.!

• On a Windows machine, you may need to use different key combo with mouse/trackpad to pan and rotate 
around the axis perpendicular to the screen. !!

Step 3. 3D navigation 

• Press 3D Crosshair Mode!

!
• Click left mouse button in the 3D view panel to place crosshair at a point on the segmentation surface. 

Note that crosshairs in the slice view panels will be synchronized.!!
Step 4. 3D scalpel 

• Press 3D Scalpel Mode and expand the 3D view to occupy the whole window!



!
• Zoom and rotate until the windpipe clearly separates from the lung on the right!!
• Change Foreground label and Background label to green and red, respectively. !
• Place a cutplane between the right lung and the rest (by clicking any two points on a desired plane). Note 

that the arrow indicates which side of the cut-plane will be assigned with the arrow color. If the side is op-
posite to what is intended, click flip button at the bottom to change the arrow to the opposite direction. 
Press accept and update to see the change. You can redo the cut plane by pressing cancel at the bottom.!

!
• Repeat similar operations for the lung of the other side using blue label as foreground and red as back-

ground label.!

!



!!!!
• Now the left, right lungs and windpipe should be labeled by three different colors/numbers.!

N.B. After pressing accept, the editing cannot be redone. You can correct the undesired label or start over by 
reloading the workspace (discard all changes).!!
Step 5 (optional). Label touch-up with Spray paint 

• You can relabel the voxels on the surface as you like. Press and hold left mouse button to achieve that if 
the final segmentation needs a touchup. Alternatively, you can edit the label in the 2D slices.!



Session 9 - convert3d

Exercise 9-A.  Resample and mask an image

Objective. Use some basic c3d commands.

Duration: 10 minutes.

Step 1. Change the directory to the data directory for Session09

• In the GUI, use the file navigation window on the right to open the data directory for Session09

Step 2. Examine template and mask

c3d template.nii.gz -info template_mask.nii.gz -info

Step 3. Resample image and mask

• The command here resamples the image and the mask to 1.5mm. After the default linear interpolation, the 
mask is no longer binary. We threshold at 0.5 to make the mask binary again, and then multiply the binar-
ized mask and template to make a brain image.

c3d template.nii.gz -resample-mm 1.5x1.5x1.5mm -o 
template_upsample.nii.gz template_mask.nii.gz -resample-mm 
1.5x1.5x1.5mm -thresh 0.5 Inf 1 0 -o 
template_mask_upsample.nii.gz -multiply -o 
template_brain_upsample.nii.gz

Step 4. View the result in SNAP
• If you don’t have the command line configured to launch ITK-SNAP, you can load the images by another 

means (for example, drag and drop onto an existing ITK-SNAP window).

itksnap -g template_upsample.nii.gz -s template_mask_upsample.nii.gz

itksnap template_brain_upsample.nii.gz

Image #1: dim = [96, 128, 80];  bb = {[-93.2977 68.1837 -64.7888], [94.2023 318.184 
95.2112]};  vox = [1.95312, 1.95312, 2];  range = [0.00990956, 4.21409];  orient = RPI

Image #2: dim = [96, 128, 80];  bb = {[-93.2977 68.1837 -64.7888], [94.2023 318.184 
95.2112]};  vox = [1.95312, 1.95312, 2];  range = [0, 1];  orient = RPI



Exercise 9-B.  Use different intensity specifications to clip an image for display

Objective. Use different intensity specification methods to clip an image for display.

Duration: 5 minutes.

Step 1. View the image t1_inverted.nii.gz in SNAP. Note the poor contrast

itksnap t1_inverted.nii.gz

Step 4. Clip the intensity range using quantiles and range

• The -verbose command outputs extra information, so we can see the exact intensities of the clip.
• Quantile mode is the default, so we don’t need to specify it



c3d t1_inverted.nii.gz -verbose -clip 0% 90% -o 
t1_clipped_quantile.nii.gz

c3d t1_inverted.nii.gz -pim fq -verbose -clip 0% 90% -o 
t1_clipped_fg_quantile.nii.gz

Step 5. Compare the images in SNAP

itksnap t1_clipped_quantile.nii.gz

itksnap t1_clipped_fg_quantile.nii.gz



Exercise 9-C.  Multilabel images, loops

Objective. Use a for loop, merge manual segmentations into a single probability and label image

Duration: 10 minutes.

Step 1. Examine different candidate segmentations

itksnap -g rater_one.nii.gz -s rater_two.nii.gz 

itksnap -g rater_one.nii.gz -s rater_three.nii.gz

Step 2. Use -staple to derive consensus segmentation from multiple candidates

c3d rater_one.nii.gz rater_two.nii.gz rater_three.nii.gz -staple 
1 -threshold 0.5 inf 1 0 -o stapled.nii.gz

Step 2. Assess similarity to candidate segmentations

c3d rater_one.nii.gz rater_two.nii.gz rater_three.nii.gz 
stapled.nii.gz -popas stapled -foreach -push stapled -overlap 1 
-pop -endfor

Try adding -verbose to give more context to the numbers.



General Commands
1 - 5 Active tool selection: crosshairs (1), zoom and pan (2), polygon (3), active 

contour (4), paintbrush (5).
< / > Cycle through foreground (drawing) segmentation labels

⌃<  / ⌃> Cycle through background (draw-over) segmentation labels
⌃L Show the label inspector window

Q / E Adjust opacity of all loaded overlay image layers
W Toggle all loaded overlay image layers on and off

A / D Adjust segmentation layer opacity
S Toggle segmentation layer on and off
X Toggle the visibility of all annotations and overlays
⇧X Toggle the visibility of the crosshair in 2D views
⌃J Automatically adjust the intensity contrast in all loaded image layers
⇧⌃J Reset the intensity contrast in all loaded image layers
⌃I Show the layer inspector window
⌃Z Undo the last change to the segmentation
⇧⌃Z Redo the last change to the segmentation

Common Image Input / Output Commands
⌃G Open a medical image as the main image layer (G stands for “grayscale”)
⇧⌃G Open a medical image as the overlay over the main image layer
⌃O Open a segmentation image
⌃S Save the segmentation image
⌃U Unload all image layers

Global Zoom Commands
⌃F Fit to size in all slice views 

⇧⌃F,1 Set zoom factor to actual size (1 screen pixel = smallest voxel extent)
⇧⌃F,2 / ⇧⌃F,4 Set zoom factor to 2x / 4x actual size 

C Center all slice views on the 3D cursor

Slice View Commands
These commands are active when the mouse cursor is in one of the slice views (axial, coronal or 
sagittal) and apply only to the selected view

Arrow keys Move the 3D cursor in-plane by one pixel
PgUp/PgDn Move the 3D cursor out-of-plane by one slice
⇧+Arrow keys Move the 3D cursor in-plane by five pixels
⇧PgUp / ⇧PgDn Move the 3D cursor out-of-plane by five slices

⌃↑, ⌃↓ Increase/decrease zoom factor in the slice view

3D Window Commands
⌃K,U Update the 3D rendering
⌃K,C Toggle automatic continuous updating of 3D rendering
⌃K,K Reset the 3D viewpoint
⌃K,S Save the 3D viewpoint
⌃K,R Restore the 3D viewpoint

Commands in Polygon Mode
When drawing a polygon

Return Complete polygon and go to polygon editing mode
⌃Return Complete polygon and accept it (add to the segmentation)
⌃V Paste the last accepted polygon

Backspace Undo the last point added
Esc Clear the polygon

When editing a polygon

Return Accept the polygon (add it to the segmentation)
+ Insert new vertices between the selected vertices
- Remove the selected vertices

Esc Clear the polygon

Commands in Paintbrush Mode
+ / - Adjust the radius of the paintbrush

Commands in Active Contour Segmentation Mode
When adding bubbles (Step 2)

+ / - Adjust the radius of the bubble
Return Add bubble at cursor

Backspace Delete bubble at cursor

ITK-SNAP 3.0 Keyboard Shortcuts
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